
Set Up Guide
for New & Home-based business

Important information on how to
■ Install EasyStart
■ Activate EasyStart
■ Get around in EasyStart
■ Find answers to your questions
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Welcome to QuickBooks EasyStart, the simplest way to manage
your sales, expenses and customers with ease. Follow these
easy steps to install your new software and get started.

1 Shut down all programs that are open, including any virus protection software.

2 Insert the EasyStart Installation CD in your CD-ROM drive. If the software does
not start automatically, do the following:

Installing EasyStart

Dear Customer,

It’s never been so easy to start your business right. 
Right from the start.
Thank you for allowing Intuit Canada to help you manage your business. We’re
excited to provide you with QuickBooks EasyStart, a breakthrough in simple
bookkeeping for new and home-based business. Designed for first-time software
users, EasyStart makes it simple to get started with extremely easy, practical tools
to manage essential business tasks. No confusing set up. No unnecessary
features. Just common sense tools that are easy to set up and easy to use.

With EasyStart you’ll be able to:

* Invoice customers and pay bills.

* Track expenses.

* View your bank account statements or run a quick Profit & Loss report.

* Always be ready for year-end taxes… or meetings with your bookkeeper!

This Set Up Guide contains important information on how to install, activate and
use EasyStart. And our customer service team is just a phone call away if you
have any questions.

We’re here to help you get the best products and services to keep you on track
and be as productive as possible. And most importantly, to help you spend more
time making money than managing it! Plus, you’ll never outgrow QuickBooks.
Even if your business grows and your needs change, it’s easy to upgrade to other
QuickBooks products.

QuickBooks EasyStart. It’s that easy. 
Sincerely,

Yves Millette
President and CEO, Intuit Canada If you purchased EasyStart... then the IKC is provided...

in a retail store on the Installation CD

by calling Intuit directly over the phone, on the packing slip 
and by email (if you provided one to 
the sales representative)

from our Web site on the Web receipt

3 When prompted to, enter your installation key code.

WHERE CAN I FIND MY INSTALLATION KEY CODE (IKC)?  Each copy of EasyStart has a
unique number which is needed to install the software. This number is referred to
as an Installation Key Code (IKC). The location of your IKC is different depending
on how you purchased your software. Use the table below to help you locate your
IKC. We highly recommend that you store your IKC in a safe place in case you need
to reinstall your software. You can record your IKC on page 5.

Click the           (Start)
button on the Windows
taskbar and select Run.

Type the letter that is associated
with your CD-ROM drive (in this
example, it is D), then type
:\autorun.exe. Click OK.



1 Open QuickBooks EasyStart.
Click the QuickBooks EasyStart
icon on your desktop, or from the
Start menu, go to Programs and
select QuickBooks.

2 The Setup Interview opens
automatically. Follow the onscreen
instructions of the Setup Interview
to create your company file. This
takes only a few minutes.
IMPORTANT When you enter your
company name and address, make
sure you select the province in which
your business operates. This is
important especially if you want to
track sale tax.

3 Once your company file is 
created and EasyStart is open,
go to the File menu and select
Activate QuickBooks.
If you choose to activate your software
at a later time, you will be asked to
activate each time you open your
company file until the 10th use. After
the 10th use, you cannot modify any
data in your company file until you
have activated.

4 Click Next and follow the onscreen
instructions.

You will activate your software by
phone or through the Internet.

* ACTIVATING BY PHONE If you activate
QuickBooks EasyStart by calling us,
the QuickBooks representative will
ask you for your Product Key number.
You can find this number on the
same screen that prompted you to
call us. The QuickBooks represen-
tative will give you a License Key
number which you must then enter in
the License Key field which is also
located on the screen that provided
your Product Key.

* ACTIVATING THROUGH THE INTERNET If
you activate through the Internet, the
software sends your product
information to Intuit and automa-
tically activates your software for you.
This is a safe and secure process.

When you have activated your
software, you can see the details of
your license information by going 
to the Help menu and selecting 
My License Information.

Write your QuickBooks EasyStart
account details here for your
reference:

INSTALLATION KEY CODE

CUSTOMER NUMBER

Activating EasyStart

Once EasyStart is installed on your computer, you must activate
your software. Activation is a fast and easy process that validates
you as the licensed user of EasyStart.
NOTE If you use the Internet, make sure you are connected to it before you begin activation.
Intuit respects your privacy. To view our privacy policy, visit www.intuit.com/canada/privacy.shtml.
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4 At the Install Options screen, choose where you want EasyStart to be installed.

5 At the QuickBooks Anonymous Usage Survey screen, select whether you want
QuickBooks to track the help topics that you go to while using your software.

By taking part in this survey, you are helping improve your software for the future.
This survey does not track any information about your company, finances,
computer, or personal matter.

To participate, keep the checkbox on this screen selected. You need not do
anything more. It’s that easy.

6 Follow the instructions until the software is installed, then restart your computer.

If you want to
install to the
default directory,
just click the 
Next button at 
the bottom of 
the screen.
To install to a
different directory
than the default,
click the Change
new directory
button, and 
specify your 
new directory.

If the software detects that Internet Explorer (IE)
version 6.0 is not installed on your computer, this
checkbox is selected. Do not clear this checkbox 
if it is selected. IE 6.0 is needed for EasyStart to
run properly.
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MENU BAR If you don’t see what
you want to do on the Home page or
in the activities listed on the left side
of the EasyStart window, you can
find it on one of these menus.

TOOLBAR Click Back and Forward to move
between forms. Click Home to return to this
Home page view. Click Find to look for a specific
invoice, sales receipt, or customer payment.

MONEY IN Basic activities related to money
coming in to your business. These activities are
the same ones that you see in Money In on the
Home page.

NEED YOUR QUESTIONS ANSWERED? Type your
question in this box, then click Ask. Our search
engine will search the online help and list all
topics that are related to your question.

YOUR BUSINESS Enter or view information
about your customers, vendors, and bank
accounts. Click Profit & Loss to see the financial
state of your business.

MONEY OUT Basic activities related to money
going out of your business. These activities are
the same ones that you see in Money Out on
the Home page.

HOME PAGE Your starting point for doing all your essential business
activities - invoicing, creating sales receipts, recording customer
payments, writing cheques for business expenses, and more. Move
your mouse over an icon, then click the activity.

GROWING YOUR BUSINESS Click these links for add-on
services, to upgrade to a different QuickBooks product when
your business outgrows EasyStart or to find an ProAdvisor.
ProAdvisors are accountants that know how to use
EasyStart and can help you set up your business in your
new software.

MANAGING YOUR
BUSINESS Click these
links for business startup 
activities, year-end
activities and assistance
with your taxes.

GET STARTED NOW Click these links
to help familiarize yourself with your
software. Use the interactive tutorials
to learn how to use EasyStart. Then
find out what to do next, and how to
get help when you need it. 

RELATED HELP Relevant help topics for your
current activity. When you change to a different
activity, the topics here change accordingly. If you
don’t see the topic you need, type a question
into the search box and click Ask. You can also
use the Help index located on the Help menu.

RELATED ACTIVITIES These activities are
relevant to your current activity. When you
change to a different activity, the activities here
change accordingly. These activities do not
appear on the Home page or on the menus.



Getting Started
TO OPEN EASYSTART
Click the QuickBooks
EasyStart icon on your
desktop, or from the Start

menu, go to Programs and select
QuickBooks. If you have no company
file created, the Setup Interview
starts automatically and takes only a
few minutes to complete. (If you
haven’t activated, see Activating
EasyStart on page 5.)

TO SET UP A BANK ACCOUNT
You’ll use it to track the
cheques you write and
deposits you make to a

real chequing account at your bank.
On the Home page in the Your
Business area, move your mouse
pointer over Bank Accounts and click
Register. Use your latest chequing
account statement to enter the
opening balance and date so your
records will be accurate.

TO USE THE TUTORIALS They’re short,
interactive, and you’ll learn how easy
it is to track your business activities.
From the Get Started Now area on
the Home page, click Check Out 
the Tutorials.

Tracking the money coming in to
your business

START BILLING YOUR
CUSTOMERS On the
Home page in the Money
In area, move your mouse

pointer over Invoices or Sales
Receipts and click New to fill out the
appropriate sales form.

RECORD AN INVOICE
PAYMENT FROM A
CUSTOMER On the Home
page in the Money In

area, move your mouse pointer over
Receive Payments and click New.
Be sure to indicate whether the
money is going directly in to your
bank account or whether you are
grouping it with other payments to
deposit at a later time.

MAKE A BANK DEPOSIT
On the Home page in the
Money In area, move
your mouse pointer over

Deposits and click New. Select the
payments that you will be taking to
the bank for deposit.

Tracking the money going out of
your business

WRITE A CHEQUE TO PAY AN
EXPENSE On the Home
page in the Money Out
area, move your mouse

pointer over Write Cheques and click
New. Fill out the cheque just as you
would fill out one in your cheque
book. You can print the actual cheque
or just track a handwritten one. If you
are tracking GST, make sure you enter
an expense category and select the
correct tax you paid on the purchase.

RECORD A CASH OR CREDIT
CARD EXPENSE On the
Home page in the Money
Out area, move your

mouse pointer over Record
Expenses. Click Cash or Credit Card
to enter the appropriate expense.

* CUSTOMERS are the people to whom you sell your products or services, that is, the
people who pay you for what you do. Some businesses might refer to a customer as
a client or a member.

* VENDORS are any businesses or people from whom you buy things for your business -
office supplies, phone or computer services, suppliers of the products that you sell,
or tax agencies that you pay.

* ITEMS are the products and/or services that you sell. You enter items on your invoices
and sales receipts.

* TRANSACTIONS are anything you record for Money In or Money Out of your business.
Whenever you create an invoice, write a cheque, or make a deposit, you are recording
a transaction in your company file.

* ACCOUNTS are used to track transactions related to your business income (e.g., sales)
and expenses (e.g., travel).

Getting around Understanding EasyStart terms
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Using the online help

* TRY THE RELATED HELP/HELP ACTIVITIES
OR THE HELP MENU On the Home
page in the lower left-hand side of
the window, you’ll see a list of help
topics that are related to the activity
you are doing. For example, if you are
filling out an invoice form, help topics
related to the creation of invoices are
displayed (e.g., filling out an invoice
and creating items). You can also
access our extensive help topics
through the Help menu located on
the Menu Bar.

* TYPE YOUR QUESTION — FIND AN ANSWER
You can search the QuickBooks 
help by typing your question into 
the search box on the Home page
then clicking Ask. You can also 
open the search engine through the
Help menu.

* HELP INDEX View an index of all 
the help topics available to you.
Go to the Help menu, and select 
Help Index.

* GET UP AND RUNNING QUICKLY USING
THE TUTORIALS These interactive
tutorials teach you the basics and
take only a few minutes to complete.
You can get to them from the Home
page under Get Started Now.

Using EasyStart online support

* QUICKBOOKS KNOWLEDGEBASE
This online knowledgebase has
hundreds of articles and 
Frequently Asked Questions. Visit
knowledgebase.quickbooks.ca

* OTHER QUICKBOOKS WEB SITES Below
is a list of related Web sites where
you can find up-to-date information
about EasyStart.

> support.intuit.ca/quickkbooks
information on QuickBooks support
and options

> www.intuit.ca to purchase Intuit
products and services

> www.intuitsupplies.ca information
on QuickBooks business forms,
cheques and supplies compatible
with your software

Contact us for additional product or service information

Getting Help Contacting Us
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* QUICKBOOKS RELATED 
CONTACT NUMBERS

> 1-877-772-9158 to purchase or
inquire about phone support with 
a QuickBooks expert.

> 1-888-333-8580 to purchase or
inquire about QuickBooks products
and services, to inquire about
activation, or ask questions about
your QuickBooks account

> 1-877-445-3233 to purchase or
inquire about Intuit Supplies
(cheques, business forms, and
other supplies)

* QUICKBOOKS PROADVISORS QuickBooks
ProAdvisors are a network of
accountants across Canada who 
are certified on the use of
QuickBooks products. Visit
http://findaproadvisor.ca to find an
advisor in your area.



Your feedback is important to us!
Any comments you provide us will be
reviewed by one of our consultants 
or engineers.

You can…

* Report a potential problem or issue
with EasyStart.

* Tell us about an enhancement that
would improve EasyStart for you.

* Let us know how we could improve
your experience with Intuit.

E-mail us at
quickbooks_feedback@intuit.com 
to provide your feedback.

© Intuit Canada, a General Partnership, 2005. All rights reserved. Intuit, QuickBooks, EasyStep,
QuickZoom, Quicken, and the Intuit logo are trademarks of Intuit Inc., registered in Canada and/or the
United States and other countries. QuickTax is a trademark of Intuit Inc. and/or Intuit Canada. All brands or
product names are trademarks of their respective holders. The software contained herein is subject to a
“single user” licence agreement. See details inside. Software is included under a limited warranty. All
features subject to change.

P/N: B06WE2056MLC

Let us know what you think
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